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Surprise! Welcome to the unveiling of the
magazine’s new layout. It is, after all, Spring in the
Northern Hemisphere, and a time of rebirth and
renewal. It seemed only fitting to reveal the new
layout with an edition of the magazine appearing in
the Spring.
To be perfectly honest, it’s something that I’ve been
toying with for the past six months or so. I’d work on
it a bit, then step away, then come back to it, then
step away, then come back to it … until it was finally
finished. At various stages, I’d run ideas and
proposals past Meemaw, for her input. We’d discuss
each item, making sure I hadn’t forgotten anything
along the various steps of creating the templates
that her and I use to layout the magazine.
The result is a layout that maximizes the amount of
space we can utilize on the page, while still
appearing stylish and attractive. One key theme in
my thought process throughout making this new
layout was to eliminate any unnecessary use of
large blocks of color, to help those who may print
pages from the magazine from having to bleed their
color inkjet cartridges dry. Another idea in creating
the layout templates was to streamline the magazine
layout process as much as possible. I can tell you
that after laying out articles this month, and putting
everything together into the final copy of the PDF for
the April, 2012 issue, that I think I’ve managed to
achieve that latter goal.
On another note, I recently had to accompany one of
my patients at the hospital to the MRI (Magnetic
Resonance Imaging) scanner in a different part of
the building. While I was waiting for my patient’s

scan to be completed, I was looking over the
shoulder of the MRI technician who was
administering the scan. Lo and behold, if that screen
didn’t look familiar. Yep! That’s it! The MRI scanner
was being controlled by software … ran on Linux!
The screen was neatly laid out, using the Motif
Window Manager. This MRI scanner – and the
software to run it – are just slightly over one year
old. So no, this isn’t any old setup. Rather, this
scanner and the special building built to hold it, was
a multi­million dollar expenditure by the hospital I
work for. I guess when you have mission­critical
data, Linux is what you turn to, huh? Of course, all of

us using PCLinuxOS already
knew that.
This month’s cover was
created by one of Timeth’s
students in Japan. Due to
laws and customs over
there, I do not know the
identity of the young lady
who created the wonderful
anime drawing we are using
for our cover this month. So
I’d like to express my sincere
thanks to her, whomever she
may be. I hope Timeth will
convey my gratitude to her.
Until next month, I wish each
and every one of you peace,
happiness, prosperity and
serenity.My father­in­law shot this picture of me working on the magazine, March 10, 2012,

during a visit to my in­laws house.

Welcome From The Chief Editor

http://pclinuxoshelp.com/index.php/Main_Page
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by Darrel Johnston (djohnston)
According to the About Update­Notifier window, it
was created by maik3531 and has been updated by
travisn000, rogaven and leiche. I believe leiche is
the current maintainer. The program has undergone
extensive modifications since it was first written.

This program is designed to check for available
updates on a time interval selected by the user, and
to notify the user of updates status via screen and
system tray icon notifications. To install the program,
open Synaptic and mark the update­notifier package
for installation. Once the program has been
installed, you will find it in the main menu in the
Software Center section.
Before starting the program, be sure that Synaptic
has been configured to connect to your selected
repository and that your network connection is
working. When the program is first launched, you will
see a status window pop up on your desktop.

Shortly thereafter, the following icon will
appear in your system tray.

The blue question mark is an indication that Update­
Notifier is not configured. Left­click the icon to see
the following configuration window.

Check for updates is highlighted by default. But,
selecting that option will put the program in the same
loop we just encountered. Highlight Change settings
and click OK, or simply double­click Change
settings. This will bring up the configuration window.

To show on screen notifications when Update­
Notifier is checking for updates, check the Enable
pop­up notifications box. If you don’t want apt­get to
prompt for installation verification when updates are
available, check the Disable apt­get verification
prompt box. You can hide Synaptic’s main window
when installing updates by checking the box for that
option. All the previous choices are optional. The
one thing you must do at this stage is select the
update check frequency. The interval can be either
days (1 through 40) or hours (1 through 18). This is
the amount of time to go between checks for
software updates. Once you are satisfied with your
choices, click the Save button. The next window will
pop up.

We are instructed to exit and restart Update­Notifier
in order to begin the software update checks. Click
OK. Select Exit Update­Notifier and click OK in the
next window.

Keep Your System Up-To-DateWith Update-Notifier
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At this point, Update­Notifier should no longer be
running. Start it from the main menu in the Software
Center section. You may receive an on screen
message that Update­Notifier is already running. In
that case, wait a couple of minutes and start it again.
If you receive the same error message again, either
find and terminate the Update­Notifier task or close
all programs and reboot. The Update­Notifier will
start automatically at each login. If you enabled
popup notifications, the following on screen window
will appear right after login.

After the check, if there updates available and you
enabled popup notifications, you will see something
similar to the following on screen message.

In addition, the Update­Notifier status icon
in the system tray will look like this.
At this point, you should click the icon in the system
tray, opening the Update­Notifier status window as
shown below.

Select one of the two Install updates choices.
Personally, I prefer using Synaptic for its visual
indications. Either selection will bring up a prompt to
enter user root’s password.

After entering the password, the package list will
again be refreshed, with a visual indicator.

Depending on whether you chose to use apt­get or
Synaptic, either a terminal window or the Synaptic
main window will appear. If you chose Synaptic, a
sub window will indicate the packages to be updated
or installed.

Mark the changes to be made and Synaptic will
display the marked changes in the main window,
unless you chose to hide it.

Click the Apply button in the Synaptic window to
install the updates. After closing Synaptic, update­
notifier will again check for new updates.

If there are no more updates, the on screen status
window will show none and the icon in the
system tray will look like this.

Update­Notifier will tell you, according to the
schedule you set, when software updates are
available. It will not automatically install the updates
for you.

Keep Your System Up­To­Date With Update­Notifier
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by Meemaw
As technology advances and we communicate with
each other more and more, we don’t just want to text
back and forth with old friends across the country,
we actually want to see them as well. So we get a
web camera to use on our computer, or have one
already on our laptop. Now we need a program that
will run our webcam. In PCLinuxOS, we can use
Cheese.
The website is http://projects.gnome.org/cheese/. If
you click on the tour links, you can learn all about it:
“Cheese is a program for the GNOME Desktop
which allows you to take photos, videos, and
anything else you can think of with your webcam.
Just start it up and shoot! Gather all of your friends
around, have some fun! When you're done, share
your photos and videos with 'em!”

After installing from the PCLinuxOS repo, Cheese is
in the Video section of the menu. When you start it
up, your camera may already be recognized and is
showing you a view of wherever the camera is
pointing. This is the main Cheese window (below
left).
You can take a single photo, a video or a burst
(series of photos) with this program. The icons at left
below the image screen let you choose which you
want. Since the photo icon was clicked, the button in
the center is what you would click on to take a
photo. If you choose video, the button will say ‘Start
Recording’’. If you want a burst, click the burst icon,
and the center button will now say ‘Take Multiple
Photos’.
The first thing you should do after you open the
program is go to Edit > Preferences. You can set

your image
resolution and
image
properties
(brightness,
contrast,
saturation and
hue), and
configure your
burst properties
­ how many
photos you want
in your series,
and how long
the program
should wait in­
between shots.

You can take up to 100 photos in your burst, and
can set a delay of up to 100 seconds. When you
take a burst, the series will be shown at the bottom

of the main window. I was practicing with the image
properties settings in my living room:

I made it too light! Fortunately, Edit > Preferences is
just a mouse click away.
There are only three menus in Cheese: Cheese, Edit
and Help. The “Cheese” menu has the majority of
the items, while the “Edit” menu just has a few.

In the “Cheese”
menu, you have the
check boxes for
Countdown and
Flash. When you
want to take a
picture, you can do a
3­second countdown
before the photo is
actually taken, and
when the photo is
being taken, Flash
makes your whole
screen turn grey for a
second or two.

In that menu are radio buttons for choosing whether
you want a single photo, video or burst (or you can
choose from the buttons in the main screen). You
can also choose whether you want the program to
be visible in full screen, or just wide mode.

Gnome 2.32: Say Cheese!

http://projects.gnome.org/cheese/
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Preferences is in the
“Edit” menu so you
can configure your
program. Notice that
you have the two
choices “Move to

Trash” and “Move All to Trash.” When you have
taken a photo or a burst, these won’t be greyed out.
You can choose a photo you don’t want and click
‘Move to Trash’, or just select “Move All to Trash”
and the program will delete them all.
Also in the “Edit” menu is another box to select or
deselect the effects screen:

The effects are shown above. This screen shows up
when you choose effects from the menu or click on
the effects button towards the bottom right of the
screen. You can choose one or multiple effects
simply by clicking on them. Clicking the effects
button again takes you back to your visible image in
the main screen with the effects applied. That way
you can see how each effect looks, but you don’t
have to take multiple photos to see them. Take your
photo, video or burst when you have the effect you

want enabled. You see below a webcam photo with
the effect “Shagadelic” enabled.

When this program is installed, a folder called
Webcam will be created in your /home. Any photos
or video you take will be saved here.
You can have loads of fun with Cheese!

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Gnome 2.32: Say Cheese!

http://www.pclinuxos.com
http://www.pclinuxos.com/?page_id=213
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Screenshot ShowcaseScreenshot Showcase
Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!

LinPC.us

Posted by gandy, March 2, 2012, running KDE 4.

http://pclinuxos.com/?page_id=188
http://pclosmag.com/html/sorted.html
http://www.linuxquestions.org
http://www.linpc.us
http://www.oneclicklinux.com
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My Space Bar isn't working I can't go to and fro
And when I hit Enter there's no place to go
No matter how hard I try I can't press Tab

This constant lack of movement is making me a crab
Would someone help me ­ pretty pretty please

The answer is very simple
You've got crumbs between the keys

The Caps Lock is being stubborn seems it is stuck
The Num Lock is the same I'm truly out of luck

I really do give up with Ctrl Alt Delete
Back to my old typewriter I'm about to retreat
Would someone help me ­ pretty pretty please

The answer is very simple
You've got crumbs between the keys

Page Up Page Down Insert End and Home
Nary a one of these am I allowed to roam

The F keys won't function I even tried Escape
And without the Delete key I'm really in bad shape

Would someone help me ­ pretty pretty please
The answer is very simple

You've got crumbs between the keys
ms_meme

Onion Sandwich
On each slice of bread you spread your favorite
mustard or spread ( mine is southwest mustard or
Kraft horseradish sauce ). You then take a nice
slice of red or white onion and place it between
those slices of bread. Sometimes wash it down
with a nice icy cold beer. I usually have a slice of

onion on just about every sandwich I have. Smileeb

Cheese & Apple Sandwich
(sometimes with a drop of lemon on the apple to stop it oxidizing)
7272Andy
Half apple, half pear, with a cup of white wine on the side for me,
thank you. Crow

Nachos gseaman
Yum, set them on the PC to keep them warm. Rudge

I have "Planters Dry Roasted peanuts", "Lays
Sour Cream and Onion Flavored chips" and
"Unique Splits" pretzels.
I could turn my keyboard over and shake it right
now and have a snack. Rudge

Forum Foibles: Crumbs Between The Keys



PCLinuxOS Magazine Page 10

My Food Rule: YA GOTTA EAT
Neal

Coffee pot, refrigerator and stove should be close to thecomputer ­ as close as is reasonably possible. Preparing,cooking/brewing and eating/drinking can then more easilybecome part of your workflow.

Put pan on stove. Low to medium heat. When pan iswarmed up, add 2 or 3 tablespoons oil ­ cover the bottom ofthe pan. Toss in sliced potatoes ­ french or cottage fry cut,your choice.
­ Back to computer ­ do some work and/or read forumposts.
­ To stove ­ turn potatoes.
­ Back to computer ­ do some work and/or read forumposts.
­ Back to stove ­ check/turn potatoes.
When potatoes are done, put on plate (on a paper towel, ifyou are concerned about the oil), salt and pepper to tasteand take to computer. Use computer with one hand and eatwith the other. Uninterrupted workflow. You just added prepand cook into it.
Ya gotta eat.

Hay there ms_meme
I don't eat sammichs at the 'puter, just the occasional milk
dud or similar candy, and not too many of them.
But when I do eat a sammich, one of my favorites.

Toasted bread (oat)
Baloney
Lettuce
Cheese (Swiss is best)
And peanut butter+Bacon and cucumber if handy

weirdwolf

I am trying not to snack.
My hubby has this snack nearly every night... one bagel,
lightly toasted, with a thin coating of peanut butter
accompanied by a small glass of milk. (sometimes he only
has 1/2 a bagel) ­ Meemaw

An Old Fashioned Fluffernutter for me with my own
little extras
2 slices of soft white bread
My extras are:
I coat 1 slice of bread with a good helping of butter.Then
the peanut butter and marshmellow on the other slice.
Mash them together and mmmmmm good eats.Now the
other extra special extra is if you have some nice crisp
bacon around add a few slices in the middle.
joechimp

Crumbs Between The Keys
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First you get your coffee set it to the right
Take a little sip keep your screen in sight
Grab a donut hold it nice and tight
Dig into those chips oh what a delight

Big slice of cake as you find your site
Dish of nachos take another bite
Pizza's in the oven so just sit tight
With goodies at your side you can surf all night

A swig of beer get a little bit tight
Handful of peanuts will make it all right
Cheese and crackers you better not slight
Wipe your chin now be polite

Move those disks make a little more space
For that Chinese take out well just in case
And before you have a hunger attack
Tell your mate to bring another snack

Now don't forget that BLT
Have a little swig of your favorite whoopee
And before you have a hunger attack
Tell your mate to bring another snack

Log into the Forum your friends to greet
Without the Sandbox you’re incomplete
And before you have a hunger attack
Tell your mate to bring another snackMP3 OGG

Crumbs Between The Keys

http://pclosmag.com/html/Issues/201204/files/crumbsbetweenthekeys.mp3
http://pclosmag.com/html/Issues/201204/files/crumbsbetweenthekeys.ogg
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open. Once you close Gimp,
the buffer resets.) You can get
to the buffer in a couple of ways.
Select Edit > Buffer > Cut
Named (or Copy named.) A
dialog box comes up allowing
you to store the image
information by giving it a name.
Once you have this in place, you
can then open the buffer, select
the image listed and paste it into
the image you're working on.
The buffer can be opened as a
free floating dock by going to
Windows > Dockable Dialogs
>Buffers. You can also add the
buffer dialog to the right hand
tool panel by selecting Add
Tabs > Buffers.

Mark's Quick Gimp Tip

At left is the Buffer clipboardin action. I selected part ofmy George comic strip, andcopied it into the Buffer. HereI'm selecting the namedbuffer. Then, from thecontext menu, I can paste it,paste it into the existingselection, or paste as a newimage.
­Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs
at georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

When doing digital photo editing,
you probably do a lot of cutting,
copying and pasting of images
and sections of images. These
copied pieces then get pasted
into the existing image or moved over to a new
image you might be creating thing is, you
sometimes want to use the same copied clip
over and over again. It'd be nice to have these
little “clippings” in a place where you could call
them up for use a little later on during the digital
photo editing process. Well, that's where
Gimp's buffer utility comes in. When you use
the image buffer, you can copy or cut an image
to the buffer clipboard, label it, and store it for
later use. (Note the Buffer is a temporary
repository. It remains as long as the Gimp is Answers on Page 37

Mark's Quick Gimp Tip & Double Take

www.gimp.org
www.gimp.org
www.gimp.org
www.georgetoon.com
www.georgetoon.com/blog
mailto:georgetoon@gmail.com
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by Paul Arnote (parnote)

You’re walking through your favorite electronics
retailer, and out of the corner of your eye, you spy
the latest, greatest, fastest, coolest, hippest, most
fantastic widge­a­woo for your computer. You pick
up the package. In the view of your mind’s eye, a
Kirilian glow surrounds the package nestled in your
hands. You marvel at the uber­cool graphics on the
package. After all, it has been sold out everywhere,
and here you are, holding it in your very hands.
Won’t the crowd on the forum be envious of you?!
As your eyes pierce through the bright glow
surrounding this prize, they stumble across the
specification list. Windows! The manufacturer only
supports Windows? That’s OK, you tell yourself in
your mind. Even though it has only been out for less
than a month, you are certain that with your Linux
knowledge and your prowess around the command
line that you can get it running.
If the above scenario sounds familiar, never fear.
You have LOTS of company. Your sentiments are
felt and shared by every Linux user that has ever
lived. Those who can’t figure out how to deal with
the hardware situation under Linux, tuck their tail
between their legs and run back to the virus­riddled
Windows world. Those who choose to “stay and
fight” meet with mixed results. Sometimes the
persistent user gets the TKO over the hardware, and
other times the hardware records a TKO over the
user. No Linux user will escape without experiencing
battle scars and bruises from fighting this gallant and
noble fight.
Throughout its entire history, Linux has had to battle
a near complete lack of support by hardware
manufacturers. Linux users, much like navigating a
dense minefield, have to seek hardware solutions in

a Windows landscape. Granted, the Linux of today
has far better support for a far wider range of
hardware than the Linux of even four or five years
ago.
Slowly – ever so very slowly – hardware
manufacturers are finally starting to support Linux.
Thanks to a tough and stagnant economy, in part, a
few are beginning to see an untapped market.
Unfortunately, that hardware support is spotty at
best. The appearance of Tux on the packaging of
hardware components is finally starting to appear, to
indicate Linux support. Still, Linux users are often
stranded like E.T. in a strange and foreign world,
and sometimes, we can’t even find the equipment to
phone home.

Somebody, anybody got a map?
So how did we arrive to this point? Well, the blame,
for sake of a better term, rests mostly on the
shoulders of the hardware manufacturers. Just take
a look at the simple economics. Linux, until quite
recently, had managed to capture only less than 1
percent of the home desktop market. Today, some
estimates place Linux adoption on home desktop
computers to be as high as 10 percent, rivaling
Apple’s OS­X on the desktop. Prior to Steve Jobs
return to Apple, even their adoption rate on home

desktop computers had dipped to less than 5
percent, by some estimates.
Microsoft’s Windows operating system, whether you
like it or not, had captured as much as 95 percent of
the desktop market at one point. Today, some
estimates have Microsoft’s market share dipping as
low as 80 percent. Even with the decline of
Microsoft’s market share, an 80 percent market
share is nothing to sneeze at. That means that no
fewer than eight out of every ten desktop computers
in use in the home are running one version or
another of Microsoft Windows.
Now imagine that you are a manufacturer of a
computer hardware component. YOU are in
business to make a profit and to keep the
shareholders of your company’s stock happy. To do
that, you target your hardware component – and all
of your support energies – to capture as much of the
predominant market as you can. Meanwhile, it’s not
in the best interest of your “bottom line” to expend
energy and man hours supporting “fringe” platforms
that represent a very, very minuscule share of the
market. Why have a cadre of programmers (or even
one) working on writing device drivers for very few
users of an operating system that is traditionally
given away for free?

The "System Requirements" portion of a Lexmark printer box.

Linux Hardware In A Windows Landscape



PCLinuxOS Magazine Page 14

This type of thinking used to be prevalent and
common during the days when computers were not
quite so common in the home. Manufacturers were
safe following that line of thinking, since not that
many people were “left behind.” But things today
have changed. Given the gross penetration of
personal computers into daily family life and homes
around the world, even an operating system with a
mere 10 percent market share represents a very
large number of users.
Unfortunately, the larger a company is, the slower it
is adapts to changes in the market. Those who are
too slow to adapt risk perishing, or having their
business wither away to a fraction of its previous
success. A great example here is Eastman Kodak.
They didn’t respond quickly or decisively enough
when the consumer photo market shifted from film to
digital. Their computer peripherals were only
“officially” supported on Windows, leaving users of
alternative operating systems to fend for themselves
and spin the roulette wheel on whether or not a
particular model worked outside of Windows.
Eastman Kodak filed for Chapter 13 bankruptcy on
January 19, 2012.
Another factor that’s often cited by hardware
manufacturers is the open source nature of Linux.
They fear making their device drivers open source.
They are afraid that it will reveal “trade secrets” of
special features of their hardware, eliminating a
marketing advantage over their competitors.

Who has found their way?
Among these changing times and demographics, a
few companies have started to openly [gasp!]
support Linux. Manufacturers of hardware
components are starting to realize that 10 percent of
a billion­plus users represents a WHOLE lot more
money in their corporate coffers than 10 percent of a
million­plus users. The increased proliferation of
home computers has definitely had an impact.

Below is a list of a handful of manufacturers who
have instituted “official” Linux support, in one way or
another, for the products in their product line, along
with a “grade” for their level of support. There are
other companies, but these are the ones that come
to mind immediately.

HP, a.k.a Hewlett Packard: of all the “large”
companies out there, HP probably has one of the
longest track records of supporting Linux users by
providing drivers for their printers and scanners. As
a result, HP printers and scanners are often the first
choice among Linux users, proving that those
companies who support Linux users will reap the
support and loyalty of Linux users. Grade: A.

Lexmark: in 2010, Lexmark reversed a long­
standing policy of not supporting Linux by
announcing official support for their printers and
scanners, with the inclusion of dedicated Linux
drivers for their current line of products. That
decision alone has caused Lexmark to leap toward
the front of the pack among hardware component
manufacturers. At one time, their printers and
scanners extruded excruciating pain from Linux
users, as they struggled to get Lexmark printers and
scanners working. Today, with official Linux support,
Lexmark printers and scanners are among some of
the easiest to set up and run. Grade: B+.

Brother: like HP, Brother has a significant history of
supporting Linux users by providing drivers for their
printers, scanners and other devices. They list 40
different Linux device drivers on their web site. They
also have a reputation of having some of the least
expensive toner cartridges for their line of laser
printers. This makes Brother a good choice if you
are looking for a printer that, in the long run, is going
to provide cost effective printing. Grade: B+.

Samsung: one of the many things that made me
choose my current printer was whether or not the
manufacturer supported Linux with drivers. Yes, I
own and use a Samsung ML­2525W wifi enabled
network printer. In recent years, Samsung has
started to offer support for Linux by providing drivers
for their printers. My Samsung printer utilizes the
Samsung Unified Linux Driver, which essentially is
one driver to manage the current crop of printers
offered by Samsung. Grade B+.

Dell: it’s no secret that Dell, one of the largest
retailers of personal computers, has flirted more than

Click on the company
logos throughout this
article to visit the site's
Linux support section.

Linux Hardware In A Windows Landscape

http://h71028.www7.hp.com/enterprise/cache/309906-0-0-0-121.html
http://support.lexmark.com/index?page=driversdownloads&linkSelected=node4%5Esubnode3&userlocale=EN_US&locale=EN
http://welcome.solutions.brother.com/bsc/public_s/id/linux/en/index.html
http://www.samsung.com/us/support/
http://search.dell.com/results.aspx?s=dhs&c=us&l=en&cs=19&k=linux+drivers&cat=all&x=0&y=0
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once with Linux. In the past, they’ve offered select
models in their computer line with Ubuntu Linux pre­
installed. Don’t go looking for them now, because it
looks like they are no longer offering an option to
purchase computers with any version of Linux pre­
installed. If they are, they are not making it very easy
for users to find them. Meanwhile, Dell does offer
Linux drivers for many of their printers. It’s also quite
easy, via an Internet search, to find links to Dell
offering servers loaded with RedHat Enterprise
Linux (RHEL). Because of their choice to not offer a
desktop solution for Linux users (or their choice to
make it extremely difficult to find), Dell’s overall
grade for Linux support suffers. Grade: C.

Hauppauge: the manufacturer of a popular line of
TV tuner cards, Hauppauge has, at best, very spotty
support for Linux. Most of their tuner cards are still
made to work exclusively under Windows.
Hauppauge offers Linux support for only one or two
models in their product line. Using any of their other
tuner cards is definitely nothing short of a crapshoot,
and the odds are undeniably tilted against Linux
users. It really shouldn’t be that difficult to make
tuner cards that work on all platforms. The only
reason they aren’t graded lower is that they have at
least some level of Linux support, as minimal as it is.
Grade: D–.

nVIDIA: having a long history of supporting Linux by
providing drivers for their line of video cards, nVIDIA

has managed to position itself as the go­to video
card for many Linux users. The nVIDIA web site has
access to drivers for not only their entire line of
current video cards, but also many of their legacy
video cards. Grade: A–.

AMD/ATI: having a significant history of supporting
Linux, AMD purchased ATI in 2006. As a result,
AMD’s support of Linux spread over to include ATI’s
video cards. The line of ATI graphics and video
cards experienced Linux support before AMD’s
purchase of the company, but took off and
blossomed after AMD’s takeover. As a result, the
nVIDIA vs. ATI “wars” among Linux users are
legendary, with ATI being the preferred graphics
card for many Linux users. Meanwhile, AMD
processors are the first choice for many Linux users.
Grade: B+.

Intel: Intel has provided quite a mixed message
when it comes to Linux support. On one hand, they
are major contributors to the Linux kernel. They
created Meego, a Linux­based, open­sourced merge
of Intel’s Moblin project and Nokia’s Maemo projects.
They have been instrumental in helping set
standards for wifi and sound. No one reading this
now would be able to do so without their
contributions to microprocessor technology.

There is no way to deny Intel’s contribution to the
computing industry. Yet, Intel’s video and wifi drivers
are often problematic and offer lackluster
performance, especially when compared with the
performance of the same video card on Windows,
and when compared with the performance of many
of their competitor’s offerings. It’s almost as if the
Linux drivers are an afterthought, without any real
work in them to allow Linux users to exploit the full
capabilities of their hardware. It’s as though they
produce minimal video drivers just so they can say
“see, it works.” When it comes to graphics drivers,
they have traditionally offered very low performance
on graphic chipsets that are capable of much more.
With all of Intel’s other contributions to Linux, it’s odd
that they seem to put so little effort into their video
drivers – and that they don’t really seem to care
about correcting that perception. As a result, many
Linux users shun Intel graphics whenever they can.
Unfortunately, it’s not always possible since many
laptops come with Intel graphics chipsets. Grade: C.

Remedies?
There have been several attempts at providing a
clearinghouse, of sorts, for Linux users to discover
which hardware components work well with Linux
and which ones do not. Unfortunately, many of those
attempts have failed miserably. It’s almost as if the
more hardware that works “out of the box” with
Linux, the more users seem less and less interested
in making additions to hardware compatibility lists.

One site that is a miserable failure is Linux­
Tested.com. Judging by the copyright range on their
home page, it was started in 1999. Unfortunately, it
appears to have been abandoned, since it hasn’t
been “updated” since 2009, the last copyright year
on the page. Maintained (and I use that term
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loosely) by AppLabs, the idea was ambitious: have
hardware manufacturers pay to have their hardware
components certified as working with Linux. But
looking at it from a hardware manufacturer’s
potential point of view, why pay for hardware
certification for an operating system that is available
for free? There are so few entries in their “database”
that it makes one think that perhaps the site was
merely a “proof of concept” idea. I suspect that
AppLabs is holding the site in stewardship, just in
case Linux ever takes off or reaches an unspecified
market penetration.

Ubuntu maintains two lists of information about
hardware that is compatible with Linux. First, they
have a list of hardware that has been “certified” to
work with Ubuntu. They also have a much larger list
of hardware that has been labeled as “friendly” to
Ubuntu, compiled by Ubuntu community members.
The Ubuntu lists are a success, and definitely a
place for Linux users to go when checking to see if a
hardware component is Linux­compatible.

PCLinuxOS also maintains a hardware compatibility
database. Formerly a standalone site, the current
version of the PCLinuxOS hardware compatibility
database is undergoing a re­genesis as a section of
the PCLinuxOS Knowledge Base. You are
encouraged to help it grow by signing up for an
account and entering information about the
functionality of your various hardware components.

It’s just as useful to enter data on hardware
components that don’t work under PCLinuxOS, as
much as it is to enter data on the items that do work.
It’s also helpful to list any special steps you had to
take to get a particular piece of hardware working on
PCLinuxOS.

The linux­drivers.org site is also a great place for
Linux users to seek information on hardware
components that are known to work on Linux. Think
of it as a central list of other lists. While some of
those other lists exist in varying states of
maintenance, the central list is actively maintained.
Currently, linux­drivers.org lists 46 other hardware
compatibility list resources. You will find lists
specializing in finding drivers and compatibility for
just printers, wifi and networking, video, sound,
scanners and just about every other kind of
hardware component you can imagine. There are
also some decent general lists mixed in.
With a simple Internet search, you can find many
more Linux hardware compatibility lists. Many of
them are specific to various distros. Nonetheless, a
lot more information exists today than what existed
even three years ago.

How you can help
It’s no secret that I just finished building my new
desktop computer. In fact, I detailed that endeavor
right here in the pages of this magazine, in the
February, 2012 issue. Besides consulting the
various hardware compatibility lists, I also scoured
the product reviews for each of the hardware

components I was thinking of buying. I bought most
of my components from Newegg.com, and they
have a fairly extensive user­based review and
feedback system. Particularly, I looked for reports
that the component worked with Linux. After I
completed building my new desktop system, I went
back to each component I purchased and added my
own review. In my review, I specifically listed each
component as working with PCLinuxOS. This way,
other Linux users (and especially PCLinuxOS users)
would have no doubts about whether any of those
hardware components would work properly under
Linux.

Summary
As more and more device drivers get rolled into the
main Linux kernel, the compatibility of hardware
components should only improve. Along the same
vein, the higher Linux’s market share goes, the more
difficult it will be for hardware manufacturers to
ignore Linux users. To continue ignoring Linux users
will definitely affect the company’s “bottom line”
profits.
Even today, Linux users can have a say. You can
vote with the money in your pocket. Avoid
purchasing hardware from vendors who make it a
habit to ignore Linux users by not providing support
or drivers for their products. When you do find an
item that lacks Linux support, send a letter to the
company’s CEO and board of directors, letting them
know that they have lost a potential customer, and
hence, untold future profits. In today’s profit­driven
corporate world, it shouldn’t take too many of those
letters to make an impact.
The message has already been heard by many
other companies. Slowly, hardware manufacturers
are coming around. They are beginning to realize
the potential market of Linux users – and extra
profits – that they have been missing out on with
their old marketing strategies. It’s only a matter of
time.
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by Meemaw
While looking at some of the programs in Gnome, I
came across three graphics programs that we
haven’t mentioned before.
Agave is a program which can help you plan a color
scheme for a graphic creation. The Help file gives
the following introduction:
Agave is an application for the GNOME desktop that
allows you to select an initial color and generate a
variety of different color schemes from that color.
The primary audience of this application is graphic
designers (and particularly web designers) though it
can be used for anything where you might need to
pick several colors that go well together, such as
painting rooms in your house.
When you open agave, you will get the main
window:

Using the color choice button on the left side of the
window (above the Palette) you choose your

preferred color from the color wheel window that
appears. As you can see above, I’m a fan of blue
and purple. Then you must decide what kind of color
scheme you want. You have six choices:
Complements, Split­Complements, Triads, Tetrads,
Analogous and Monochromatic. You can also use
the Palette at the bottom of the window to choose
your colors. Notice on each color chip are the color
name (303acf on the blue above at left), along with
the hue, saturation and value numbers (236, 77, 81)
and the red, green and blue values (48, 58, 207).
Using those, you can recreate any color correctly no
matter what program you are using.
Also in the toolbar there are two pairs of arrows. the
left ones increase or decrease the brightness of your
colors, and the right ones increase and decrease the
saturation of your colors so you can get them just
right. When you have them right, you can choose to
add that color scheme to your favorites.
Gnome Paint is a simple paint program, reminiscent
of MS Paint or the older Paintbrush.

Actually, it looks exactly like MS Paint to me.
However, upon use, I have found this program
barely works at all. I did manage to draw the heart
with the paintbrush, but no matter which size brush I
chose, I only got the biggest size round brush. If I
choose the selection box (at the top of the right­hand
column of tools), I could draw a box around anything
I wanted, and drag the box all around the canvas,
but I couldn’t cut, copy, move or delete anything that
I had drawn. Maybe it’s me. However, clicking on the
eraser tool (second from the top in the left­hand
column), I could drag it over my whole drawing and
couldn’t erase anything.
The view, image and color menus have no items,
either. With all the other drawing programs I can
use, I’m going to uninstall Gnome Paint.
GPhotoFrame is a program which allows you to put
a frame on your desktop and run a slideshow of your
favorite photos. In your graphics menu, it is called
Photo Frame. When you first open it, you will see a
black screen with a plain frame around it. Right­
clicking the black screen will give you a menu.

Gnome 2.32: Graphics Extras
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You should configure your Preferences first.

The general tab lets you configure the time between
photo changes. Window mode and full screen mode
can have different intervals. You can also set the
maximum size for the frame, have it start when you
start your computer, and have it show on whatever
workspace is visible at the time.

The plugins tab shows you the sources you can
access for your files. If configuring it to use Flickr,

Picasa Web or Tumblr, you should highlight your
preferred site and click on the Preferences button
below. You will be asked for your user name and
password so the program can access your account
on the site. Flickr asks permission to access the site,
then takes you to a Flickr sign­on screen. When you
sign on, the following window appears:

If you want GPhotoFrame to access Flickr, you
should click the blue box in the center of the window
that says “You arrived at this page because you
specifically asked GPhotoFrame to connect to your
Flickr account....”. From here you complete the
authorization on Flickr, then go back to the
Preferences window in GPhotoFrame and finish the
process.

The third tab of Preferences is Photos. Here is
where you actually tell GPhotoFrame where your
photos are located. If you only want to access a
certain folder in your system, or if you want to get
them from Flickr, you need to add the location by
clicking new. Another window will appear asking you
to designate the location of your photos. I chose my
wallpaper folder.

To do a fullscreen slideshow, simply right­click the
frame and choose Full Screen. To go back to the
frame, right­click the slideshow and your menu will
appear again and you can uncheck the Full Screen
checkbox.
You can move the frame anywhere on your screen,
unless you right­click and choose “Fix Photo Frame”.
This choice will ‘stickie’ your frame to your desktop
wherever it happens to be located. I have noticed
however, that even when ‘stickied’, the frame moves
on the desktop. It resizes itself every time the image
size is different, and instead of fixing a certain corner
to a specific spot (for example, the top left corner of
the frame could be fixed to the screen wherever you
stickied it), it just keeps resizing and ‘crawling’ until
the frame is somewhere else. Other than that, it’s a
very nice program, and very easy to use.
As with any program, or any desktop for that matter,
you should pick the ones that are easiest for you to
use, and work best for you.

Gnome 2.32: Graphics Extras
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by Darrel Johnston (djohnston)

PC­BSD is a variant of FreeBSD, intended for use
on the desktop. PC­BSD was originally founded by
FreeBSD professional Kris Moore in early 2005. The
first Beta only had a GUI installer to get the user up
and running with a FreeBSD 6 system which
contained a pre­configured KDE3. This was a major
innovation for the time. FreeBSD is designed as a
server operating system, and anyone who wished to
install FreeBSD to a desktop or workstation would
have to manually tweak and run through a text
installer. Kris Moore's goal was to make FreeBSD
easy for everyone to use on the desktop. It has
since diverged even more in the direction of usability
by including additional GUI administration tools and
PBI packages.
Since October 2006, PC­BSD has been supported
by the enterprise­class hardware solution provider
iXsystems, which now employs Mr. Moore as a full
time developer. In November 2007, iXsystems
entered into a nationwide distribution agreement
with Fry's Electronics stores to carry boxed copies of
PC­BSD in their stores. In January 2008, iXsystems
entered into a similar agreement with Micro Center.
In June 2010, Dru Lavigne became the PC­BSD
Director of Community Development. Dru pretty
much wrote the book on FreeBSD. She is a network
and systems administrator, IT instructor, technical
writer and former director of the FreeBSD
Foundation. She has been using FreeBSD since
1996, has authored several BSD books, and spent
over 10 years developing training materials and
providing training on the administration of FreeBSD
systems. Dru is the author of BSD Hacks, The Best
of FreeBSD Basics and The Definitive Guide to PC­
BSD. She has well over a decade of experience

administering and teaching Netware, Microsoft,
Cisco, Checkpoint, SCO, Solaris, Linux and BSD
systems. She is also the founder and Managing
Editor of the Open Source Business Resource, a
free monthly publication covering open source and
the commercialization of open source assets, as well
as being the founder and current Chair of the BSD
Certification Group Inc., a non­profit organization
with a mission to create the standard for certifying
BSD system administrators. As I said, Dru pretty
much wrote the book.
PC­BSD used KDE exclusively until version 9.0,
which has been customized to support tighter
application integration. While manual installation of
other desktops was technically possible before
version 9.0, none of them were supported, and
major functionality was lost when not using PC­
BSD's special build of KDE. GNOME is now offered
as an alternate desktop, along with Xfce, LXDE and
other desktop environments. PC­BSD supports x86
and x86­64 architectures.
PC­BSD 9.0 Isotope Edition is the current version
and the one we will be looking at. There are several
versions that can be downloaded from PC­BSD’s
Isotope download page. There is a DVD with all
desktops and optional components, or a CD with the
LXDE desktop and no optional components. There
are several USB versions, as well as VMware and
VirtualBox images. Torrents are also available, and
all versions are available in either 32 or 64 bit
designations. We will be using the 32 bit DVD.
Booting from the DVD, we see the screen at top
right.
Option number one is the default, and the boot
menu has a ten second countdown timer. The
installer will be launched after boot, instead of a live

desktop session. In the first welcome screen, we are
asked to choose our language, local time zone, and
whether or not to synchronize our system time with
an internet time server.

Next, we are asked to choose our keyboard type
and any variant of it (next page, top left).
In the system installer step (next page, lower left),
we have a choice of installing either a PC­BSD
desktop or a FreeBSD server. We also have a

Alternate OS: PC-BSD, Part 1
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choice of installing either from a local DVD or USB
or from a network or internet location. Here, we’ll
choose the PC­BSD desktop and install from DVD.

In the disk setup section, there are tabs for basic
mode or advanced mode. We will stick with the
default basic mode. I created a 12 GB hard drive for
use with the VirtualBox installation. The installer
selected that disk by default as the medium to install
to. I have chosen to use the entire disk. Note that if
you are going to be sharing your PC­BSD
installation with other operating systems on the
same drive, PC­BSD must be installed to a primary

partition. It cannot be installed to an extended
partition. In BSD terms, a primary partition is called a
“slice”. The slice is then further subdivided into BSD
partitions. PC­BSD does not include a partition
manager. You are expected to have a primary
partition, or BSD slice, already prepared for
installation. If you are sharing the installation with
other operating systems, there are some additional
steps to be performed which will not be shown here.
Please consult the PC­BSD Users Handbook or Wiki
for further information. The add and delete partition
buttons are to be used for BSD partitions and are
best left to the advanced BSD user. We have a
choice of using the traditional BSD UFS filesystem
or using the newer Solaris ZFS filesystem. It is the
same ZFS filesystem previously covered in the
OpenIndiana articles. However, PC­BSD
recommends using the 64 bit OS, as well as having
a minimum of 4 GB of system RAM for ZFS. We’ll
choose the UFS filesystem. We can also choose to
encrypt our user’s data. The “Partition disk with
GPT” option is for use with ZFS.

In the users section, there are two tabs. One is for
users setup and the other is for system options.
Advanced users may elect to change some of the
system options. Here we are asked to create a
system password for the superuser account, as well
as a user account and a password for that user. We

also have a choice of default shells. We can choose
from csh, tcsh, sh, bash and zsh. I chose the more
familiar bash shell for my user. Click the save
changes button before proceeding to the next step.

The desktop section has a lot of choices. The first is
our desktop environment. KDE is selected by
default, but I chose to use XFCE instead. The other
choices are Gnome and LXDE.

In the hardware drivers section of the desktop
screen, we can choose to install HP line printer
drivers, handheld device drivers, such as

Alternate OS: PC­BSD, Part 1
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smartphones, tablets and MP3 players, and nVidia
video drivers.

In the miscellaneous section of the desktop screen,
we can choose from Compiz, MythTV,
VMwareGuest, VirtualBoxGuest and XBMC device
drivers. I chose to install VirtualBoxGuest drivers.

In the services section of the desktop screen, we
can choose to install support for a database server,
Samba (Windows ServerMessageBlock protocol)
and a web server. So, one could install a FreeBSD

server setup with ZFS filesystem and web services
from the PC­BSD installation DVD.

The last section of the desktop screen is for
unsupported desktop environments. Only
experienced FreeBSD users need apply. The
desktops offered are Awesome, FVWM, IceWM,
Openbox, ScrotWM and WindowMaker.
Hootiegibbon would be proud. Note that although
Fluxbox is not presented as an option, it is installed
by default in PC­BSD. It is always available as a
second desktop environment.

There are two possible choices in the sources
portion of the installer. They are FreeBSD system
source and FreeBSD ports collection. If you choose
either one of them, it is best to choose only one.
Both can be used, but must be carefully managed by
an experienced user. FreeBSD system source is the
choice for those who wish to compile packages so
that applications will be optimized for their specific
hardware and needs. The ports collection option is
for those who wish to install pre­compiled binary
packages. On a PC­BSD desktop, neither option is
necessary. One can use the applications that exist
on the system after installation, as well as adding
self­contained PBI packages which are unique to
PC­BSD. We’ll look at the ports collection and PBI
packages in detail in the next article. I recommend
you choose to install the ports collection in this
installation step.

In the pre­installation summary screen, we are
shown all of our previously selected installation
options. We can click the back button to step
backwards through the installation process and
make any changes. Once we click the next button,
one last dialog window pops up asking whether to
continue the installation (next page, top left).
The installation screen gives us a progress bar and
shows what packages are being installed. As the

Alternate OS: PC­BSD, Part 1
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message in the window says, depending on your
system’s speed and the options chosen, the
installation may take a while.

Once all files have been copied from the DVD to the
hard disk, the last screen is displayed showing that
the installation has completed. At this point, remove
the installation DVD and reboot the computer or
virtual machine to complete the installation (center,
top).
First boot from the hard drive shows a different boot
screen. There are six boot options and four boot

actions which can be selected. I chose boot option
number six, Run the Display Wizard.

In the display settings setup window, there are two
tabs, general and advanced. I was only interested in
changing the screen resolution available under the
general tab. I changed it from the default 1024x768
24 bit color depth to 1152x864 and the same color
depth. The other option, other than screen resolution
and color depth, is the video driver to use. Because I
had installed the VirtualBoxGuest drivers, the vbox
video driver was chosen by default (top right).

After clicking the apply button, I was presented with
the user login screen.

I clicked on my user name, then entered the
password in the next dialog window. The desktop
environment to be used for the session can be
chosen from this screen. There are also language,
keyboard and shutdown options (next page, top left).

After a few seconds, I was presented with PC­BSD’s
default XFCE desktop (next page, lower left).

Alternate OS: PC­BSD, Part 1
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In the next article, we will examine the installed
package managers and applications, as well as
customizing the desktop and adding more
applications.
Shown at right is the always present optional
Fluxbox desktop.
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by Chuck Rice (Ramchu)

I recently installed a financial program, called Kraft,
which is geared toward running a small business.
When I would start the Kraft program, it would open
with a box stating that it was starting the Akonadi
server and then would do nothing further. I couldn't
even close the program without logging off and back
on.

I looked in Synaptic Package Manager and could
see that Akonadi server was indeed installed, and
this left me scratching my head wondering what I
would have to do to get Kraft working.
So off to the PCLinuxOS forum I went to post my
question, and then I remembered the forum search
function, as I am sure that my question has already
been asked and possibly answered before.
First, where do I search? Do I search from the
software section, or the networking section since it is
a server that is unable to start? I finally decided to
search from the home section of the forum, as when
you search from home the search function searches
the entire forum for answers.
Next, what do I search for? Do I search for Akonadi
server or Kraft or Program won't start?
I decided to search for Kraft as a start, expecting to
get eight or 10 pages of search results to sort
through. To my surprise there was only one page
with nine results, and the second result was the
answer to my problem. I didn't have kaddressbook
and its dependencies installed, so after pulling these
in from Synaptic and doing a restart of my computer,
Kraft now opens and operates as expected.
The forum search is your friend and should be the
first line of defense for solving PCLinuxOS problems.
One may have to search several times to get the
search parameters correct in order to get the results
that are needed for your particular problem, but it's
definitely worth the effort.
Just remember that your problem most likely isn't
unique, and it has more than likely been asked
already.

Support PCLinuxOS! Get Your OfficialPCLinuxOS
Merchandise Today!

Searching For AnswersOn The PCLinuxOS Forum
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by Meemaw
Continuing our coverage of Linux financial
apps that we started last month, we will
explore iFreeBudget this month. The
homepage is
http://sourceforge.net/projects/ifreebudget/
, and since this program is written in Java,
it runs on any OS with Java installed. I
couldn’t find a users manual, but an FAQ
page resides at
http://www.ifreebudget.com/. iFreeBudget
is also in the PCLinuxOS repos.
When you open iFreeBudget for the first
time, you are required to establish a user
name and password. After that, you will
have to login with your password. This
keeps your financial data more secure,
just in case someone had access to your
computer while you happened to be signed on.

The window you see now is already set up
somewhat, with some accounts already entered
(checking, savings, income). This program uses
double­entry bookkeeping, which simply means that
every entry is an account. Money goes out of an

asset account into an expense account. Your
checkbook is an account and each category that
gets money is an account. When you enter a
transaction in iFreeBudget, you assign a ‘from’
account (generally your checkbook) and a ‘to’
account (the person or company the check is
paying).
Income is under the “Income” category, with
“Primary Job” being the default account. The
“Assets” section contains “Checking,” “Savings” and
“Cash in Hand” categories, with default accounts
defined as “Primary Checking,” “Primary Savings”
and “Wallet.” The “Expense” category lists some
common expenses, such as Groceries, Restaurant,
Bills, Car Gas and Misc Purchases, but with no
predefined accounts. The “Liability” section is where
you’ll find the “Credit Cards” and “Loans” categories.
You can create the appropriate accounts for these,
as well.

You may edit the “Assets” section by
right clicking on the checking account
entry and changing it as you desire. I
changed mine to “Meemaws Checking.”
You can then customize the Expense
part of the the list by putting in your own
categories and adding accounts to those
categories. Right click a category, such

as Bills, and
choose “Add
account.”
You’ll be
presented
with a window
where you
can add an
account to the
category of
your choice.

Continue adding categories and accounts until you
have what you need. I eventually renamed the
category “Car Gas” to “Automobile,” then added the
accounts “Fuel,” “Auto Payments” and “Insurance.”

The toolbar
contains the
following buttons:
New Account, New
Transaction, New
Transaction
Wizard, Address
Book, Portfolio
Manager, Logout
and Exit. You can
always click on the
New Account
button in the
toolbar, but you

Linux Financial Apps: iFreeBudget
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will get an extra window asking in what category you
are placing it. Either way, whether you’re using the
toolbar button or right­clicking the category, you will
be able to easily add an account.
The New Transaction button is for adding
transactions to your account. The New
Transaction Wizard takes you through
adding a transaction a step at a time, but
takes it a little further. The Address Book
button is just what you think it is: you can
import your address book into the
program. The Portfolio Manager lets you
enter your stock portfolio information and
track its value. Logout will save and close
your account window but will keep the
sign­on screen available in case you want
to add more later. This is more secure than
leaving the account file open if there are
others in the house. There is also an Exit
button, which closes the program
completely.
Let’s add some transactions. Click on the
New Transactions button. You will get the
following window:

On the left and right you have the same tree. On the
left you need to choose the account that is paying
the bill (Meemaws checking), and on the right the

payee account that is getting the money (Grocery
Store). In the center you enter the amount and date
of payment ($95.00 on 2/18/12). Clicking Save,
you’ll see the window close and your transaction in
the list.

From the screenshot above, you can probably see
the same thing I can: the balance column seems to
be in error. I have no explanation for this, other than
the program may be balancing each account, rather
than showing the checking account balance as we
are used to seeing it. I started the checking account
with $500 and have added $500 twice since, and
now that line does say $1,500. However, the other
lines don’t do the same thing, so it confused me.
The most reliable place to see the checking account
balance is the lower half of the window, where in the
third line it says
“Current Balance”.
Actually, the best way
to see how much you
have paid into any
particular payee
account is to choose
that one in your tree at

the left. I chose Grocery Store in the image below
and it has the balance I have paid (two checks, one
for $80 and one for $95).
Of course, after you get all your expense accounts

listed, and need amounts for tax purposes,
it would be silly to look them up one­at­a­
time. iFreeBudget has a Reports feature.
From the Reports Menu, you can pull up a
Cash Flow report or an Earnings report.
Each can be customized to include the last
week, the last month or the range of your
choice. The Cash Flow report for the range
1/1/12 to 2/26/12 is shown below. You
could make your range 1/1/12 to 12/31/12
at the end of the year to do your taxes.

iFreeBudget also does scheduled (or recurring)
transactions. You can set up a transaction for once
per month, or whatever other interval you need. If

you pay your car payment every
month, you can set up your checkbook
to do that. You will need to use the
Transactions Wizard (the magic wand
in the toolbar). When you click it, you
will get the following window (next
page):

Linux Financial Apps: iFreeBudget
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The choices are “I received an income,” “I paid for
an expense using my checking/savings account,” “I
paid for an expense using my credit card” and “I paid
my credit card/loan bill.” You can choose “I paid for
an expense using my checking/savings account”
and click next. Just as with any transaction, you will
be asked to designate the “From” account
(checking), the “To” account (car payment) and the
Details (amount and date of payment). When you
get to the Save screen, you will be asked if this is a
recurring transaction. If you click Yes, you can then
designate how often the payment occurs and when it
should end, if known, and then click Finish.

This program has a couple of features I hadn’t seen
in very many other programs. One is an address
book feature. Any address book that you can export
as a csv file can be imported into iFreeBudget. From
the Tools menu, choose Address Book. You will get
a blank address book with several buttons at the top:
Add (to add a single contact), Edit (if the name,
phone or email changes), Delete (delete a contact),
Import (to import your list), and Close. Clicking the

“Add” button allows you to add all information to the
contact screen, but all that will show up in the main
address book screen with be name, phone number
and email address. Double clicking a name will bring
up the contact screen with all information.
Another feature in iFreeBudget is a Stock Quote and
Portfolio. From the Tools menu, first choose Get
quotes. If you know the symbol of the stock you are
interested in, put it into the symbol box and click Get
quote. You should get a window like the one below.

You will see a great range of information, plus a
graph of prices for the last three weeks. It is just as
easy to add items to your portfolio. From the Tools
menu, choose Portfolio (top right). Click Buy to add
in the items that are included in your own portfolio.
This screen will show a list of items you’ve added,
today’s price, value of your shares and whether they
have increased or decreased today. If you click on
one stock and click on Details, you will get the
information from the quote screen as well. If you sell
part of all of a stock, click on Sell and complete the
window that pops up.
Just like last month’s program, iFreeBudget also has
a couple of oddities. One of them, of course, is the
balance column in the register. Another one is that I
like my transactions to be sorted from oldest at top

to newest at bottom. I can change it, but it doesn’t
stay. Finally, there are so many things that could be
configured, and the only thing in Edit > Preferences
is how the date is displayed. Other than that, it’s not
a bad program.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Linux Financial Apps: iFreeBudget
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by sarcastic_bastard (David Lally)

The following is a list of common tasks I find
necessary to do after install and rebooting, as well
as a few extras that have been worked out over time
to fix a few annoyances. I thought by putting all of
this in the one spot, it might be of help to someone,
and can look thru and see what steps you may have
left out that you might think are useful to you.
Ok, downloaded and installed Gnome on my main
desktop, dual­booting with Win7 (which I need for
certain work requirements). I give 12 GB to /, 4 GB
to swap, and the rest (180 GB or so) to /home.
I have another box with Mint 9 that i use as a central
repository for all my files, acting as a file­server (via
NFS and Samba), torrent box (Transmission), and
as a BOINC client. Since it’s free most of the time, it
may as well be doing something useful.
After installing and rebooting, setup with root and
user credentials, then log in. For myself, I setup as
root, then logged into it, since I needed to change a
couple things for the user ID, due to the Mint 9 user
ID. Went into Control Center and created user and
group “david,” and manually set the user ID to 1000
instead of 500 (which is the default). A user ID of
1000 is what Mint/Ubuntu uses as default, and I was
having share issues (with earlier installs) until I clued
on to why. Set that up, log out of root, and then log
in as user.
Open terminal, “su” to switch to root, and run
“echo ­e "MDV_MENU_STYLE=upstream" >>/etc/sysconfig/menustyle”

to change the PCLinuxOS Gnome menu back to the
standard Gnome menu, as I much prefer its
categories and layout. I personally find the standard
Gnome menu much easier to work with, but you may
be happier with it as it is.
Move the Show Desktop applet from bottom­right to
bottom­left. Right­click on it and untick "Lock to
panel", then do same to the little "Window List" icon
at bottom right. Then right click on the Show
Desktop icon again, and select "Move", dragging it
all the way to far left, leaving Window List icon (the
little upright rectangle with a dot at the center) just to
the right of it. Then right click on both and lock them
in place again.
Add the Trash applet next to the Workplace switcher
at the bottom­right. Right click on the bottom panel,
and select Add to Panel. Select the Trash applet
from the list available, dragging it down to the
bottom right. I stick it just to left of Workplace
Switcher icon, but you may prefer the right, or
somewhere else altogether. I definitely find it useful
having it just a click away.

Open Control Center > System > Manage Date and
Time. Set to my/your country and locale. Enable
Time Network protocol, and select server nearest
my/your location
In Control Center, go to Network and Internet > Set
up new network interface. Choose wireless/
ethernet/however you connect, then your network
interface (eg. eth0) , then for “Please select your
connection protocol” I recommend leaving as the
default “Automatic IP”, then for IP settings, leave at
“Get DNS servers from DHCP” checked (this
ensures your IP is set by your router’s DHCP
server), while making sure to set your hostname
below (whatever name you want your PC called on
the network). Complete the setup with defaults, and
finish. If you are already connected, it will
momentarily close the connection and recreate it,
with the added details now. Wireless connection will
ask for your wireless password during setup. Be
sure to enter it correctly, as it is easy to fail to
connect if you get it wrong. Your connection sets up,
and your PC now has a properly set hostname.
Even if you run thru Ethernet, and are already
connected, I still suggest doing this. It will at least
provide the PC with a proper hostname.
Open Synaptic, and select the repo to one nearest
me/you. Then, click on Reload so it has the most up
to date list of packages on the repo. I choose
Internode, since it is close, well maintained and
regularly updated. Check to see if your ISP mirrors
the repo. If so, it should be faster for you. If you are
an Internode customer, you’ll be able to download
from it quota­free. I used this a lot when I was using
them at one house I was at.
Right­click on the clock at the top right, select
Preferences, and make sure details are correct
(Location, Weather details, etc). Set up properly, you

Some PCLinuxOS GnomePost Installation Tips
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should get your local weather shown beside the
clock, which is quite handy.
Ensure all drives are mounted correctly in the
PCLinuxOS Control Center. They should be, but
often your Windows drives/NTFS are not, and that is
up to you whether to leave then unmounted or not.
Set up Video card in PCC. I like to do this to make
sure it is using the Proprietary driver for my Nvidia
card, as I want/need hardware acceleration.
Use the chown command (as “root") in a Terminal to
reclaim ownership of the files on my storage drives
(eg. “chown ­R david:david /media/MY_STUFF
/media/STORAGE­1TB /media/Hitachi­1TB”).
Open Nautilus, go to Edit > Preferences > Display.
Set the top option to size, the second option to type,
then Ok and close. Feel free to experiment and see
which settings suit you best. I find this works for me.
Also, make sure to untick “Show hidden files and
folders.” Otherwise, you’ll have the view of all your
“hidden” folders clogging up your view.
In Nautilus, I also drag all my commonly accessed
folders to the left pane as shortcuts. This saves me
a lot of time chasing them down, and makes them
easily accessible.
I installed Guake, a drop­down terminal, as I like
having a terminal at hand, without getting in the way,
or needing to be launched separately all the time.
Once installed, run it, then it will be sitting in your
tray ready to be used. By default, F12 will activate it,
dropping it into your view, and F12 again will make it
retract. To ensure it starts automatically when you
login, go to System > Preferences > Startup
Applications, and look for Guake. It will be there, but
not ticked/activated by default. Enable, and enjoy.
You'll find it very handy if you use command­
line/Terminal at all.

Install Comix as a reader for my digital comics (.cbr
and .cbz files). Make sure it is set as the default
viewer. Otherwise, it attempts to open them with the
Archive Manager, which is no good for viewing
them.
Install Dropbox and set it up. I find it handy to keep a
copy of certain files and documents at all times at
hand, and when moving around from the desktop to
the netbook, to the notebook, and other desktops in
the house, it's much simpler to keep them all
synchronised and at hand. I used to copy them
around, but those changes weren't always copied if I
was forgetful. Dropbox fixes this.
I install and use Kompozer for simple web­page
creation. I came up with the idea a while ago, as I
tend to forget to save my bookmarks and assorted
fave sites, so I created a simple Home­page and
added all the sites I commonly visit (here included),
as well as add anywhere new I find of interest and
want to make sure I can find again (my memory is
pitiful). Simple page, add the links, then
names/descriptions. I save this in my Dropbox
folder, so any changes/additions I make are
reflected across all copies, and it's always up to date
with my wanderings.
Next, I install privoxy (http://www.privoxy.org/) from
the repos. I use it to filter out a lot of adverts and
assorted cr*p on the web. Since I tend to use and
install multiple web­browsers (Firefox, Chromium,
Opera, etc) it's simple to install, then make sure that
browser is set to point at it as a proxy. In Firefox, go
to Edit > Preference > Advanced > Network >
Settings, set to Manual Proxy Configuration, then set
HTTP Proxy and SSL proxy to 127.0.0.1 and the
ports to 8118 for both. Now, all your web­traffic is
filtered thru Privoxy, and a lot of junk is never
loaded.
For a lot of good Firefox extensions, I go here
http://www.gnu.org/software/gnuzilla/addons.html.
These are all Free, and released under Free
Software licences. I've discovered a few nifty ones

here that I had not even heard of before. There are
far too many to wade through on the main
extensions site. My main ones are Scriptish
(Greasemonkey fork, seems to work better),
Greasefire (when you are on a page/site, it can
show you what scripts are available for the site, etc),
Secure Login (operates like Opera’s “Wand" and
enables you to login to sites you visit with one click,
after you’ve logged in then first time and it
remembers your details) and DownThemAll (mass
downloader). Aside from those, my faves are the
Evernote extensions (only started using this a
month or so ago, and it is sooooo useful), Flagfox,
Video Downloadhelper (for ripping vids and picture
galleries from sites, including Youtube, etc),
Ghostery (https://www.ghostery.com/, very handy,
since it blocks a lot of sites snooping on your
browsing, also shows the surprising number of sites
that follow you around the web), HTTPS­
Everywhere (automatically makes sites use HTTPS
for added security if available), and Social Fixer
(previously BetterFacebook). There's plenty to
choose from.
I also install the Netusage extension for Firefox also
(http://netusage.iau5.com/). It's great for me, but
could also be useful for others to keep track of their
net usage, and how much quota is used/remains. It’s
a must. You install it, restart the browser, go to View
> Toolbars > Customize, and drag it onto your
browser bookmark where you like, then right­click on
it, and choose Preferences, adding your details so
that it can grab your stats from your ISP. I have mine
set to update hourly. It's very useful, allowing me to
keep good track of my usage.
Oh, and before I forget, install libdvdcss2 if you plan
to be able to play/read/rip/backup encrypted
(commercial) DVDs. I also install DVDDecryptor
under WINE (after installing WINE, of course) to rip
my DVDs to hard drive, where I usually then point
Handbrake (which is also a strong recommendation
to install) at them to rip the disc contents to a .MKV
file (or, if you prefer, MP4) for local playback. This
spares my discs from excessive
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movement,scratching, fingerprints, etc, since I do
most of my viewing at my PC anyway, and only dig
them out if actually planning to use the (region
unlocked) DVD player with the TV. Also, if using
DVDDecryptor, when you first run it, it won’t see the
DVD drive on your machine. Go to Tools > Settings
> I/O, and change it to ASPI, and OK. Also, by
default it rips them to a folder inside the WINE folder,
which means you have to burrow down after them. I
change this by going to Tools > Settings > General,
go to Default Destination, and switch from Choose
Automatically to Semi Automatic, allowing you to
designate a folder to save the unencrypted results
to.
For excellent CD rips, I prefer Rubyripper­gui, and
set it to rip them to both OGG and FLAC. The
OGG’s are for loading onto my Samsung Galaxy
phone (saves room), and the FLAC’s are for playing
from PC, etc (better quality, lossless sound).
GPrename is an excellent bulk­renaming utility. I
used to use Pyrenamer, and it’s still good, but I find
GPrename to have just that bit more options and
features, so it wins.
I sometimes download from certain sharing sites
(Rapidshare, etc), and for that, jDownloader is
excellent, and proven to be best of all the tools I’ve
tested for this purpose, as well as being cross­
platform (also available on Windows). It also can be
used as a general download manager. It’s not let me
down yet.
VideoCut is an open source desktop application
specialized for creating compositions of screenshots
from video files. I use this to create a screenshots
sample with each DVDrip. It’s quick and simple.
If you haven’t already done so, log out and back in
to allow most changes to take effect. Now you
should have a desktop that caters to virtually all your
needs. If not, search and add more. Choice is a
wonderful thing.

Screenshot ShowcaseScreenshot Showcase

Posted by djohnston, March 9, 2012, running LXDE.

Some PCLinuxOS Gnome Post Installation Tips

http://pclinuxos.com/?page_id=7
http://pclosmag.com


PCLinuxOS Magazine Page 32

by Jim Wilkinson (jimwilk)

With KDE, I know there is a handy KMix display in the system tray. There are
times when the volume is too high, too low, or muted, and it just seems to take
too long to find the little symbol and change the setting. A few handy keyboard
shortcuts might be faster.
First of all, go to Configure Your Desktop and select Shortcuts and Gestures from
the top row:

Then choose Global Keyboard Shortcuts:

and, under KDE component, select KMix

Scroll down this list and change keyboard default from None to:
Decrease Volume Alt + , (ie < sign)
Increase Volume Alt + . (ie > sign)
Mute Alt + M

You can choose the specific key you want to use with Alt. When you are finished,
click OK and you have yourself a handy set of keyboard volume controls. I use
the Alt key to the right of the space bar because it is right near the required keys.

Screenshot ShowcaseScreenshot Showcase

Posted by aguila, March 9, 2012, running KDE 4.

KMix Keyboard Volume Controls

http://www.linpc.us


PCLinuxOS Magazine Page 33

by Paul Arnote (parnote)

The formal 12th annual poll of Linux users on the
LinuxQuestions.org forum started on December 28,
2011. Electrons swirled and whirled as users voted
for their favorite applications in 31 different
categories. Voting continued until February 5, 2012.
As you might imagine, there were a few “surprises”
in the voting results.
Only registered members could vote at the forum,
and were limited to one vote per member per
category. Members were not required to vote in
every category. Rather, they could skip categories
that they had no knowledge of, or that contained
software that they didn’t use.
In case you’re not familiar with it, LinuxQuestions.org
maintains a relatively distro­agnostic forum. There, a
wide range of topics of interest to Linux users are
discussed. Each of the “major” distros has their own
sub­boards in the forum. There are also boards for
new users, hardware, notebooks, desktops,
networking, and several other boards that represent
areas of interest for Linux users.
Here are the individual categories, along with the top
five finishers in each category. The icon of the top
vote recipient is shown above each category.

Programming Language Of The Year
Python took the top honors, obtaining nearly 30
percent of the overall votes in this category. Second

place was swooped up by the C programming
language, followed by C++, PHP and Perl.

Text Editor Of The Year
Vim ran away with the top honors this year,
obtaining over 31 percent of the votes in this
category. Gedit took second place with just over 15
percent of the votes, with Emacs, Kate and Nano
filling out the rest of the top five spots, respectively.

Browser Of The Year
Firefox was the runaway favorite for browser of the
year, garnering almost 57 percent of the votes.
Chrome was a distant second place finisher, with
nearly 18 percent of the votes. In order, Opera,
Chromium and SeaMonkey rounded out the rest of
the top five spots.

Desktop Environment Of The Year
KDE took the top mark as users’ favorite desktop
environment, with a solid 33 percent of users
selecting it as their favorite. Perhaps one of the

biggest upsets this year is how Xfce has overtaken
Gnome for the second place spot. Xfce was selected
as the favorite desktop environment for nearly 28
percent of users. With the move from the more
traditional desktop of Gnome 2.3x to Gnome Shell in
the past year, Gnome fell to a distant third place
finish, with only 19 percent of the votes. LXDE took
fourth place, while the Unity desktop took a very
distant fifth place.

Database Of The Year
MySQL was the runaway favorite database among
Linux users, taking in 50 percent of the votes.
PostgreSQL was the second place finisher, with 25
percent of the votes. SQLite, Firebird and MariaDB
rounded out the top five finishers.

Messaging Application Of The Year
Pidgin was, by a large margin, Linux users’ favorite
messaging application. It raked in over 53 percent of
the final vote. Kopete took a distant second place,
with just over eight percent of the vote. Irrsi took the
third spot, closely followed by Xchat and Empathy.
The latter two ended up in a tie for fourth place.

2011 LinuxQuestions.orgMembers Choice Awards
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Network Monitoring Application Of The Year
Nagios ran away with the top spot in the category for
network monitoring application of the year, with
nearly 65 percent of the votes. Zabbix was a distant
second place, followed by Idnga and Shinken tying
for third place. Munin brought up the rear of the top
five applications in this category.

Media Center Of The Year
XBMC edged out MythTV as Linux users’ favorite
media center software, taking 48 percent of the final
vote, compared to 33 percent of the vote for
MythTV. Boxee and Google TV tied for a distant
third place finish, while Elisa was a very distant
fourth place finisher.

Graphics Application Of The Year
It should be no real surprise that Gimp repeated its
string of top honors in this category, getting just over
72 percent of the final vote. Inkscape took second
place, with just over 10 percent of the votes, with
Blender taking third place with just under eight
percent of the final tally. Scribus and ImageMagick,
respectively, filled out the fourth and fifth place
finish.

VoIP Application Of The Year
Skype was the “no­surprises­here” runaway favorite,
obtaining nearly 60 percent of the final votes. Ekiga
took a distant second place, getting just over 14
percent of the votes. Empathy and Mumble tied for
third place, with just over four percent of the votes.
Linphone and Twinkle tied for fourth place, with just
under four percent of the votes.

Audio Media Player Application Of The Year
Amarok, while once again capturing the top spot, did
so this year without the runaway victory that it had
experienced in years past. It’s unclear if changes in
Amarok over the past year are responsible, or if the
other audio media players are getting that much
better. Nonetheless, Amarok captured nearly 20
percent of the final votes. Audacious came in
second place, with nearly 14 percent of the final
votes. Rhythmbox posted a very close third place
finish, while Clementine and Banshee were the
fourth and fifth place finishers, respectively.

Window Manager Of The Year
Openbox narrowly beat out Compiz by only one vote
as the favorite window manager, with both obtaining
just under 16 percent of the votes. Fluxbox came in
third place, with just under 14 percent of the votes.

KWin and xfwm4 were the fourth and fifth place
finishers.

Open Source Game Of The Year
Battle For Wesnoth took the top honors in the open
source game category, with just under 19 percent of
the votes. Open Arena grabbed just under 10
percent of the votes, to lock up a second place
finish. SuperTuxKart, Frozen Bubble and OpenTTD
rounded out the rest of the top five vote getters.

Open Source CMS/Blogging Platform Of The
Year
WordPress won first place as a nearly 2:1 favorite
over its closest rival, Drupal, capturing nearly 49
percent of the votes, compared to almost 25 percent
of the votes captured by Drupal. Joomla! took in just
under 14 percent of the votes to capture third place.
Fourth place was taken by TYPO3, while Alfresco
and XOOPS tied for a fifth place finish.

Backup Application Of The Year
Rsync grabbed a first place finish with just over 37
percent of the votes. AMANDA came in second
place, with right at 15 percent of the votes. Tar,
Clonezilla and luckyBackup rounded out the top five
vote recipients.

2011 LinuxQuestions.org Members Choice Awards
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Desktop Distribution Of The Year
This category came down to the wire, with a head­
to­head battle for first place between Ubuntu and
Slackware. Ubuntu edged out Slackware for the top
spot by just two votes. Debian came in third place,
while Linux Mint and Arch came in fourth and fifth.
PCLinuxOS finished in eigth place, just behind
Fedora and openSuse, and just ahead of
CruchBang and Bodhi.

File Manager Of The Year
Just as with the desktop distribution of the year
category, this contest came down to a heated, down
to the wire contest between Dolphin and Nautilus,
with the former edging out the latter by only one
vote. Thunar posted a solid third place win, while
Midnight Commander came in fourth. PCManFM
was the fifth place finisher.

Server Distribution Of The Year
Debian and Slackware battled it out for the top spot,
with Debian narrowly beating Slackware by only nine
votes. CentOS came in third place, while Red Hat
Enterprise Linux came in fourth. Ubuntu LTS won
the fifth place slot.

IDE/Web Development Editor Of The Year
Eclipse captured 22 percent of the vote in this
category, making it the first place finisher for
applications in this category. Geany, the multi­
talented IDE and text editor, took second place
honors in the IDE/Web development editor category,
with almost 15 percent of the vote. Third place went
to Bluefish, while fourth and fifth place went to
Emacs and Netbeans, respectively.

Configuration Management Tool Of The Year
Puppet brought home the first place trophy for
configuration management tool, with nearly 55
percent of the vote. Second place went to Cfengine,
with almost 14 percent of the vote. Third place went
to Spacewalk with a little over 12 percent of the vote.
Chef and Salt Stack brought up the last of the top
five places, with a fourth and fifth place finish.

Video Media Player Application Of The Year
VLC swept up more than twice the number of votes
of its closest competitor, Mplayer, to capture 61
percent of the votes, compared to only 30 percent of
the votes for Mplayer. Third place went to Totem,
with just over three percent of the vote. Fourth place
resulted in a tie between Xine and Dragon Player.

Mobile Distribution Of The Year
It’s probably no surprise to anyone with a pulse that
this year’s mobile distribution of the year is Android,
capturing nearly 70 percent of the votes. Second
place went to CyanogenMod, which curiously
enough, is also related to installing and upgrading
new versions of Android on Android devices, with
just over 14 percent of the votes. Meego captured
third place, with just under six percent of the votes.
Curiously, Maemo is listed in fourth place, despite
Maemo having been rolled into the Meego project.
WebOS was the fifth place finisher.

Virtualization Product Of The Year
VirtualBox coasted to an easy first place finish,
getting over 61 percent of the vote. Second place
went to VMware, with just under 15 percent of the
vote. KVM, the KDE virtual machine manager, came
in third, with just under 14 percent of the vote. Qemu
was in fourth place, with Xen coming in fifth place.

Open Source Web Framework Of The Year
Django edged out Ruby on Rails for the first place
finish, with just over 32 percent of the vote,
compared to almost 29% of the vote for Ruby on
Rails. Zend Framework captured third place with
almost nine percent of the vote. CodeIgniter came in
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fourth place, while CakePHP, Spring and Yii all tied
for a fifth place finish.

Office Suite Of The Year
Less than one year after its debut, LibreOffice has
captured the top spot among office suites, capturing
over 81 percent of the votes. OpenOffice, the former
front runner in this category, took a distant second
place with just over 14 percent of the votes. GNOME
Office captured third place, with KOffice and Lotus
Symphony bringing up the rear.

Audio Authoring Application Of The Year
Audacity repeated its reign at the top of the heap,
capturing another first place finish this year with
nearly 78 percent of the votes. Ardour came in a
distant second place, with less than eight percent of
the votes. LAME took third place with seven percent
of the vote, with Rosegarden and LMMS taking
fourth and fifth places, respectively.

Revision Control System Of The Year
Git captured more than twice as many votes as its
closest competitor, Subversion, with nearly 59
percent of the votes, versus just under 25 percent of
the vote for Subversion. Mercurial took a solid third

place finish, while CVS and Bazaar rounded out the
top five spots.

NoSQL Database Of The Year
Cassandra and MongoDB tied for a first place finish,
both capturing just over 26 percent of the votes.
CouchDB was a close second place finisher, with
almost 23 percent of the votes. HBase and Redis
took third and fourth places.

Video Authoring Application Of The Year
FFmpeg ran away with the votes in this category,
capturing just over 34 percent of the vote for a first
place finish. Kdenlive captured second place with,
getting just over 15 percent of the vote. Close on its
heels was Avidemux, capturing just under 15
percent of the vote. Openshot and Blender brought
up the rear for the top five spots.

Host Security Application Of The Year
SELinux captured four times as many votes as its
runner­up, capturing 51 percent of the votes to
capture first place. Rootkit Hunter came in second,
with under 13 percent of the vote. AppArmor took
third place with just over eight percent of the vote.
Samhain and Tripwire tied for fourth place, each with
just under seven percent of the vote.

Summary
There you have it: the top Linux applications in 31
separate categories, picked by Linux users
themselves. If you want to participate in next year’s
poll, be sure to log in at the LinuxQuestions.org
forum next January.

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

2011 LinuxQuestions.org Members Choice Awards

http://www.pclinuxos.com/?page_id=10
http://www.pclinuxos.com/?page_id=542
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Screenshot ShowcaseScreenshot Showcase

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Visit.
Contribute.

Build.
The PCLinuxOS
Knowledge Base

It Belongs To YOU!

Answers to Mark Szorady's Double Take:
(1) Table different; (2) Pocket and pen lower;
(3) Hubcaps missing; (4) Moustache added;
(5) “4th” changed to “5th”; (6) “Cramped”
changed to “small”; (7) Tie stripes different

Posted by ferry_th, March 5, 2012, running Openbox.

http://www.linuxforum.com
http://www.opensource.org/
http://twitter.com/iluvpclinuxos
http://cozmodesigns.co.uk/phinx/
http://pclinuxoshelp.com/index.php/Main_Page
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By longtomjr

I asked my dad, longtom, to help find me an app that
would play my sheet music and he stumbled upon
MuseScore. This is great for musicians of any kind
... even drummers. It can display tabs and does
have a LOT of instruments available.

The great thing about MuseScore is that it has a lot
of scores available at the web site. You can also visit
the official website at http://musescore.com. You can
also “watch” video scores, where the score is
displayed on the left side of the screen, and it
follows along with the video that is displayed in the
right side of the screen.
To make a new project, you can use the wizard. It is
very user friendly.

So, here is a short look
into it. At the start, you
choose the composer
and lyricist, which is a
must when you want to
post it on the .com
website for other users.
This will also make it a
lot easier to find.

Here you can choose to
start from scratch or use
a template. We will use a
template. When you use
a template, you will
choose from a couple of
sheet­formats and then
choose your sharps or
flats.

This is a handy app. What makes it different from
other score apps is that it plays every instrument.
Just one more thing. MuseScore can display tabs,
drum­lines and LOTS of other instruments. Also, a
lot of tutorials are available on YouTube.

Visit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclinuxos­mag"
(without the quotes)

A Short review: MuseScore

http://ge.tt/9twFf7A?c
http://www.linuxfoundation.org/
http://musescore.com/sheetmusic
http://musescore.com
http://www.youtube.com/results?search_query=musescore+tutorial&oq=musescore+tutorial&aq=f&aqi=g1&aql=&gs_sm=3&gs_upl=1109l5798l0l6022l14l14l0l9l9l0l100l474l4.1l5l0
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by Darrel Johnston (djohnston)

In Linux, everything is a file, or is associated with a
file. There are filesystem types, such as ext3, xfs,
ntfs and btrfs. But this article is not about the
different filesystem types. It is about the structure of
the PCLinuxOS filesystem.

It all begins with root. Not the superuser root's
directory, which is /root, but the root of the
filesystem, which is /. All directories start from the /
(root) directory. Shown below is a graphic depiction
of a typical layout.

If we do a root directory list on our PCLinuxOS
installation, we'll see the following files and
directories.
bin/
boot/
dead.letter
dev/

etc/
home/
initrd/
lib/
lost+found/
media/
mnt/
Module.symvers
null
opt/
proc/
root/
sbin/
srv/
swap/
sys/
tmp/
usr/
var/
Each file and directory
in the root directory is
owned by the
superuser, root. Only
root has full read, write
and modify access
here. Let's begin with

the files. dead.letter is created or added to when a
mail program cannot deliver the contents to the
intended recipient. The one on my system is mostly
the results of msec system security checks that
could not be emailed. Module.symvers contains

information about the native kernel modules. A quick
check of the file's date and time stamp shows it was
copied from the /var/lib/dkms/nvidia­current/290.10­
1pclos2011/build/ directory. The source file contains
the line:
0xeb97fcd5 nv_linux_devices
/var/lib/dkms/nvidia173/173.14.30­
1pclos2011/build/nvidia EXPORT_SYMBOL
Whereas the line only appears once in the original
file, the line appears three times in /Module.symvers.
It obviously has to do with the dkms­nvidia­current
package, but I'm not sure why the line appears three
times.
The purpose of the file null in the root directory is
unknown. This file is not to be confused with
/dev/null. I do not know what process creates this
file.
Some directories can be put onto separate partitions
or systems for easier backups due to network
topology or security concerns. Other directories have
to be on the root partition, because they are vital for
the boot process. 'Mountable' directories are:
'/home', '/mnt', '/tmp', '/usr' and '/var'. Essential for
booting are: '/bin', '/boot', '/dev', '/etc', '/lib', '/proc'
and '/sbin'.

/bin
The /bin directory contains useful commands that
are of use to both a system administrator as well as
non­privileged users. It usually contains shells, like
bash, and commonly used commands like cp, mv,
rm, cat, ls. The binaries in this directory are
considered to be essential because the directory
contains system programs that must be available

Image from http://linuxconfig.org/Filesystem_Basics

Linux File System Heirarchy Explained

http://linuxconfig.org/Filesystem_Basics/


PCLinuxOS Magazine Page 40

even if only the partition containing / is mounted.
This situation may arise should you need to repair
other partitions but have no access to shared
directories. (For example, if you are in single user
mode and have no network access). It also contains
programs which boot scripts may depend on. The
/bin directory contains no subdirectories.

/boot
The /boot directory stores data that is used before
the kernel begins executing user­mode programs. It
contains everything required for the boot process,
except for configuration files not needed at boot
time, (those that belong to the GRUB boot­loader),
and the map installer. This directory may include
backup master boot records, sector/system map
files, the kernel and other important boot files and
data that is not directly edited by hand. Programs
necessary for the boot loader to be able to boot a file
are placed in /sbin. Configuration files for boot
loaders are placed in /etc. The PCLinuxOS /boot
directory has two subdirectories, grub and
lost+found.

/dev
The /dev directory is the location of special or device
files. It highlights one important aspect of the Linux
filesystem ­ everything is a file or a directory. Look
through this directory and you should see sda1,
sda2, etcetera, which represent the various
partitions on the first master drive of the system.
/dev/cdrom and /dev/fd0 represent your CD­ROM
drive and your floppy drive. This may seem strange,
but it will make sense if you compare the
characteristics of files to that of your hardware. Both
can be read from and written to. Take /dev/dsp, for
example. This file represents your speaker device.
Any data written to this file will be redirected to your
speaker. If you try “cat /boot/vmlinuz > /dev/dsp” in a
terminal on a system where the sound card has
been configured, you should hear some sound.

(Turn your volume down before trying it!) That's the
sound of your kernel.
The majority of devices are either block or character
devices. However, other types of devices exist and
can be created. In general, block devices are
devices that store or hold data, and character
devices can be thought of as devices that transmit or
transfer data. Diskette drives, hard drives and CD­
ROM drives are all block devices, and serial ports,
mice and parallel printer ports are all character
devices. The /dev directory contains no
subdirectories.

/etc
This directory contains all system related
configuration files here or in its subdirectories. A
configuration file is a local file used to control the
operation of a program. For this reason, it's a good
idea to backup this directory regularly. It will save
you a lot of reconfiguration time later if you reinstall
or lose your current installation. Normally, no
binaries should be located here. There are quite a
few subdirectories here, notably the X11 directory,
which contains all the configuration files for the X
Window System.

/home
Linux is a multi­user environment, so each user is
also assigned a specific directory that is accessible
only to them and the system administrator. If your
username is jane, your home directory will be
/home/jane. You can write and delete files, as well
as install programs within your home directory. It
also contains your personal configuration files and
folders, the so­called dot files. (The file name is
preceded by a dot). Personal configuration files are
usually hidden. If you want to see them, you either
have to turn on the appropriate option in your file
manager or use ls with the ­a switch. The settings in

a personal configuration file will override system
configurations while logged in as a user.
When a new user is created, their dotfiles will be
taken from the /etc/skel directory. The dotfile most
likely to be altered by a user is the .bashrc file. It
contains aliases, user­specified commands and
environment variables. Your home directory can
become quite large when used for storing
downloads, email, image and sound files, as well as
other documents. Note that although the superuser
root owns the /home directory, each user's individual
home directory, for example, /home/jane, is owned
by the user.

/initrd
The /initrd directory provides the capability to load a
RAM disk by the boot loader. The RAM disk can
then be mounted as the root file system, and
programs can be run from it. Afterwards, a new root
file system is mounted from a different device. The
previous root file system (from /boot/initrd.img) is
then moved to a directory and can be subsequently
unmounted. The /initrd directory is mainly designed
to allow system startup to occur in two phases,
where the kernel loads with a minimum set of
compiled drivers, then additional modules are
loaded from /boot/initrd.img. The PCLinuxOS /initrd
directory contains a single file, README.WARNING.
The contents of the file are:
(mkinitrd) Don't remove this directory, it's needed at
boot time, in the initrd, to perform the pivot_root.

/lib
The /lib directory contains kernel modules and
shared libraries needed to boot the system and run
the commands in /bin and /sbin. Libraries are readily
identifiable through their filename extension of *.so.
The Windows equivalent to a shared library would
be a DLL (dynamically linked library) file. They are

Linux File System Heirarchy Explained
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essential for basic system functionality. Kernel
modules (drivers) are in the subdirectory
/lib/modules/”kernel­version”, where “kernel­version”
is a kernel installed on your system. An example
would be /lib/modules/2.6.38.8­pclos1.bfs/.

/lost+found
Your Linux system should always be shut down
properly. Sometimes your system might crash, or a
power failure might take the machine down. Either
way, at the next boot, a lengthy filesystem check
using fsck will be done. Fsck will go through the
system and try to recover any corrupt files that it
finds. The results of this recovery operation will be
placed in the /lost+found directory. The files
recovered are not likely to be complete or make
much sense, but there is always a chance that
something worthwhile is recovered. Each partition
also has its own lost+found directory. If you find files
in there, try to move them back to their original
location. If you find something like a broken symbolic
link to a file, you have to reinstall the file(s) from the
corresponding RPM, since your file system was
damaged so badly that the files were mutilated
beyond recognition.

/media
This directory contains subdirectories which are
used as mount points for removable media such as
floppy disks, cdroms and zip disks. Historically, there
have been a number of other different places used
to mount removable media such as /cdrom, /mnt or
/mnt/cdrom. Placing the mount points for all
removable media directly in the root directory would
potentially result in a large number of extra
directories in /.

/mnt
This is a generic mount point under which you
mount your filesystems or devices. Mounting is the
process by which you make a filesystem available to
the system. After mounting, your files will be
accessible under the mount point. There is no
limitation to creating a mount point anywhere on
your system. But, by convention, and for practicality,
do not litter your file system with mount points.
Before one can use a filesystem, it has to be
mounted. The operating system then does various
bookkeeping chores to make sure that everything
works. Since all files in Linux are in a single directory
tree, the mount operation makes it look like the
contents of the newly mounted filesystem are the
contents of an existing subdirectory. An example of
partitions and their related mount points can be seen
by reading the /etc/fstab file.

/opt
This directory is reserved for all the software and
add­on packages that are not part of the default
installation. For example, LibreOffice, Adobe and
VirtualBox packages are found here. All third party
applications should be installed in this directory. Any
package to be installed here must locate its extra
fonts, clipart, database files, etcetera, in a separate
/opt/”package” or /opt/”provider” directory tree,
where “package” is a name that describes the
software package and “provider” is the provider's
LANANA (Linux Assigned Names And Numbers
Authority) registered name. The structure of the
directories below /opt/”provider” is left up to the
packager of the software, but are generally installed
in /opt/”provider”/”package”.

/proc
The /proc directory is very special in that it is also a
virtual filesystem. It doesn't contain actual files, but
runtime system information, such as system

memory, devices mounted, hardware configuration,
etcetera. For this reason, it can be regarded as a
control and information centre for the kernel. In fact,
quite a few of the system utilities are simply calls to
files in this directory. For example, “lsmod” is the
same as “cat /proc/modules”, while “lspci” is a
synonym for “cat /proc/pci”. By altering files located
in the /proc directory, you can even read and change
kernel parameters (sysctl) while the system is
running. The most distinctive thing about files in this
directory is the fact that all of them have a file size of
0, with the exception of config.gz, kcore, mounts and
self.

/root
This is the home directory of the superuser, root. In
former days, / was root's home directory. To keep
things tidier, root got his own home directory. But,
why not in /home? Because /home is often located
on a different partition, or even on another system,
and would thus be inaccessible to superuser root
when only / is mounted.

/sbin
Linux discriminates between executables available
to all users and those used for system maintenance
or administrative tasks. The latter are in /sbin. This
directory contains binaries that are essential to the
working of the system. These include system
administration, maintenance and hardware
configuration programs. For example, you will find
lilo, fdisk, init, ifconfig and others here.
Another directory that contains system executables
is /usr/sbin. This is where you will find the network
daemons for your system, along with other binaries
that generally only the system administrator has
access to, but which are not required for system
maintenance and repair. Usually, these directories
are not part of a normal user's search path, only of

Advertisement
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root's. Programs executed after the /usr directory
has been mounted are generally placed in /usr/sbin.

/srv
The /srv directory contains website specific data
which is served by the system. The main purpose is
so that users may find the location of the data files
for a particular service, and so that services which
require a single tree for readonly data, writable data
and scripts, such as cgi scripts, can be reasonably
placed. If you have no web services installed on
your system, the /srv directory will be empty.

/swap
The purpose of the /swap directory is unknown. This
directory is not to be confused with the swap
partition. I do not know what process creates this
directory.

/sys
The /sys directory is actually a virtual filesystem
which is a counterpart to /proc. It provides a lot of
non­process related, detailed information about the
in­kernel status to userspace. The subdirectories are
block, bus, class, dev, devices, firmware, fs, kernel,
module and power.

/tmp
This directory contains mostly files that are required
temporarily. Many programs use this to create lock
files and for temporary storage of data. Do not
remove files from this directory unless you know
exactly what you are doing. Many of these files are
important for currently running programs and
deleting them may result in a system crash. The files
usually won't contain more than a few KB anyway.

The directory can be cleared on reboot by setting
the appropriate configuration, if so desired.

/usr
Although the /home directory can potentially contain
much more data, the /usr directory usually contains
the largest share of data on a system. This is one of
the most important directories in the system, as it
contains subdirectories with user binary
executables, their documentation, libraries and
header files. X and its supporting libraries can be
found here. In the original UNIX implementations,
/usr was where the home directories of the users
were created. In current UNIX flavors, /usr is where
userland programs and data are. The name hasn't
changed, but it's meaning has narrowed and
lengthened from "everything user related" to "user
programs and data".

/var
The /var directory contains variable data such as
system logging files, mail and printer spool
directories, and transient and temporary files. Some
portions of /var are not shareable between different
systems. For instance, /var/log, /var/lock, and
/var/run. Other portions may be shared, notably
/var/mail, /var/cache/man, /var/cache/fonts, and
/var/spool/news. Why not put it into /usr? Because
there might be circumstances when you may want to
mount /usr as read­only, for example, if it is on a CD
or on another computer. /var contains variable data
the system must be able to write to during operation,
whereas /usr should only contain static data.

International CommunityPCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

Brazil
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On the banks of the Linux River stood ms_meme shy coquette
She was looking for a penguin or anything else that she could get
She put her mouse into the water and gave a little click
I need a new operating system and I need it really quick
Little ms_meme was using Windows hear those cries of distress
Soon they’ll be a happy ending when she finds PCLOS
On the other side of the river sat little Tux so innocent
He didn’t know that catching him was ms_meme’s intent
He put a flipper into the river some fishing he would try
He didn’t see ms_meme googling him with her eye
Poor little Tux knows how the Wind Blows he heard her SOS
He pulled his line from the river and reeled in PCLOS
Now ms_meme jumped in the river reached out for that life line
She wrapped it tightly around her knew all would soon be fine
What have I done said little Tux I must be a nitwit
I’ve given PCLOS to a blooming idiot
Now ms_meme loves little Tux gives him a fond caress
As she sails along the internet in the USS PCLOS

ms_meme's Nook: Linux River

MP3 OGG

http://pclosmag.com/html/Issues/201204/files/linuxriver.mp3
http://pclosmag.com/html/Issues/201204/files/linuxriver.ogg
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By Gary L. Ratliff Sr. (eronstuc)

Two very interesting things happened on March 8,
2012. First, I learned that the March issue of the
magazine was out and I downloaded the PDF format
version. Second, my new 1080p High Definition TV
arrived. Unlike Walmart, which is providing a three
month period to layaway items during the Christmas
season, QVC provides the ability to pay for items
over a period of months. The Roku I mentioned in
the February issue was paid for in four easy
payments. As I was jumping around on the tube, I
stopped and learned that they had a high Definition
TV available for five easy payments. When I ordered
it, they told me that my TV would arrive on March
13th. Then they gave me a tracking number. And by
checking my email, I learned that it would be coming
in on the day’s run. It arrived at 1:00 pm. After that, I
was quite busy setting up all the items for the new
system.
As I already had one computer which runs Windows
95 connected to my 720p HDTV, I decided to see
what my best computer would look like at 1080p. On
Tuesday, I had met an old former workmate from the
MagneTek QC department. He mentioned that as
we are either both over 70, or soon will be, our
hearing and eyesight are not what they were when
we were inspecting parts. Now my appraisal of the
eMachine may have to be truthfully revised. We
removed the USB devices and cables for the printer
power supply, mouse and keyboard from their
sockets, and moved the table into the front room,
then re­attached these same items to the computer.
Upon boot, only this error message appeared on the
new HDTV screen:
error: df0 cannot get C/H/S valuesgrub rescue>

Well, what command do you try to make magic?
Boot, reboot, go. The three­finger salute spelled out
doesn’t do anything either! The remedy was to place
a Live DVD with The Full Monty in the drive, press
F12 to get to the boot menu and tell the machine to
boot from the DVD drive. Now I have a full set of
tools to write this article and to see how the new
HDTV performs as a monitor. In the March issue of
the magazine, a window is mistaken as an HDTV!

Here you can see some of the items which have
been attached to the various ports of the HDTV: To
the right is a 27” standard TV. The 32” HDTV with
the internet page from the Full Monty is shown in the
middle and the Roku is shown under the HDTV. The
17” monitor and the speakers of the eMachine are
shown on the left. On top of the 27” is a VCR and a
DVD player. Attaching the VCR to the Roku allows
you to make VCR copies of the movies. Where I live,
Turner Classic Movies is good for movies without
any commercials.
After I had downloaded the March issue, I was able
to view it at a whopping 300% magnification which

just filled the screen comfortably. So with this, I don't
have to spend time looking all over the place to see
just where I have laid down my glasses.

In the midst of this, my daughter told me that my dog
Liz had gotten lost while in her care. I called many
animal shelters and vets in an attempt to locate her.
I finally resolved that Liz was not going to be
returned. If you found a dog this cute you most likely
would keep it too. This is from Facebook which is
provided by the Roku.
Now we returned to the problem of getting the
eMachine to boot. Surely just moving the computer
from one room to another should not be such a
traumatic experience for a computer! As I had web
access, I searched for eMachine support and
entered into a chat with one of their technicians. I
had encountered the tech named Andy who thought
that because he was a computer engineer with
eleven years experience he should ask me to part
with $38.00. HaHaHa! I’ve had near thirty five years
working with computers and know how to look up
data as well as this joker.

A Really Large Monitor
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Anyway, the tech suggested that a system recovery
be performed. So I performed a recovery first to
preserve the files I had downloaded. I did a second
one to produce a recovery to factory defaults. Both
of these methods yielded the same error message
that originally appeared. As you see, my pictures of
the monitor taken with the camera have the flash
showing, which hides the lower part of the text.
Anyway, here is Windows showing just how well it is
designed. I think I could have moved my HP out and
it would have performed perfectly. My good rating for
the eMachine may well have been unfounded.
(Perhaps Tom Kent was right!)

One thing to be thankful for was that I have
downloaded over 100 various distros of Linux live
CDs or DVDs from DistroWatch. After reporting my
experience at not being able to get Windows to boot,
another tech said they would have a set of recovery
DVDs sent to me.
I thank you all for inquiring about why you had not
heard from me. When Trudy passed away, her last
request was for me to take care of her little dog.
Moving in to a No Pets Allowed apartment and
placing the task of keeping Liz was perhaps an
unfair burden on my daughter. In parting, I will say I
miss Liz very much. There is a video of her and
Toby on YouTube if you would like to see these

champs in action. There are also videos showing
how to set up a multi­boot multi­tasking system, too.
From my Facebook page, here is my profile picture
and a final tribute to a very cute little dog.

Screenshot ShowcaseScreenshot Showcase

Posted by YouCanToo, March 1, 2012, running KDE 4.

A Really Large Monitor

http://www.tuxmachines.org
http://www.csolisphotography.com/iso/
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by Jim Wilkinson (jimwilk)

Readers of the January 2012 issue of The
PCLinuxOS Magazine might recall an article that I
wrote about using PCLinuxOS in a high school
classroom.
At a recent meeting of the Palmerston North Linux
Users' Group in my home city here in New Zealand,
I suggested that I would like to make the same sort
of Linux demonstration available in other local high
schools. As a result of my suggestion, I have drafted
a letter to the Head of Computing in the local
schools. I hope to make contact with those people
soon to work out how I can assist them.

March 2012
The HOD Computing
Demonstration of Linux Operating System to
Computer Classes
I am a member of the Palmerston North Linux Users'
Group and, at the same time, a retired teacher of
mathematics. My registration as a secondary
teacher is still current although I have recently
ceased working as a relief teacher at Feilding High
School. Local schools where I taught over the years
are Awatapu College, Feilding High School and,
slightly further afield, Paraparaumu College.
Since retiring from the classroom in 2004, I have
been learning to use a Linux Operating System as

an alternative to Microsoft's Windows ©. Last year, I
was able to take my laptop along to Feilding High
School and, show students the features of a
particular distribution of Linux – PCLinuxOS. As you
probably know, these operating systems are totally
free. Therefore, I took along Live CD's of the system
and gave them to students to try.
At a recent planning meeting of the executive of the
above mentioned Palmerston North Linux Users'
Group, I suggested that I would be interested in
broadening my contacts with local high schools as a
Linux liaison person.
If you were interested, I would be happy to bring
along my laptop with its Linux OS to demonstrate it
to some of your computing classes. I know that
schools do study other operating systems than
Microsoft Windows ©. Such a visit could be timed to
fit in with your teaching programme. At the same
time, I would be delighted to provide Live CD's of
one or more of the most popular Linux systems for
students to take home and try on their own
machines. The Live CD doesn't install anything on
the computer – unless the operator chooses to do
so.
Initially, you might prefer that I visit the school, at a
time suitable to your programme, and discuss my
ideas with you. I have talked to my former colleague,
Kerry Flavall at Awatapu College, and found him
receptive to the suggested approach.

Get ‘em while they are young
Let’s hope that my efforts to spread the word about
Linux are warmly received. After all, imagine how far
we can help Linux spread when we get the youngest
users “hooked.”

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer
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Posted by coffeetime, March 11, 2012, running Openbox. Posted by MtnMan, March 7, 2012, running e17.

Posted by Crow, March 17, 2012, running KDE 4.Posted by DarkEra, March 1, 2012, running Xfce.

More Screenshot Showcase






